Email Client (Thunderbird)

A Ratsupport.com presentation by Richard C. Anderson on why Email
clients are good and you should think about using one.



Discussion

* Email clients give you a way to manage your email and keep your
Information on your computer.

 Email clients also provide an easy way to backup your email
Information.

* You can use Microsoft Outlook ($$) or Mozilla Thunderbird ($0.00)
and it is easy to backup. There are other email clients in the world.

* Clients help manage Junk Mail (Spam) without loosing good emails.

* If you have any questions that are not answered by this presentation
then | suggest contacting us or doing a google search.

e Five Best Free Emall Clients

02/11/21 Presentation by Ratsupport.com


https://www.auralsolutions.com/2012/12/how-to-backup-thunderbird-data-emails-and-contacts/
https://www.ratsupport.com/contact/
http://www.techradar.com/us/news/software/applications/windows-7-email-5-best-free-clients-903699

Discussion

* As the hackers figure out new ways to steal
Information the ISP's and email people come up with
new ways to keep you safe.

» 2 Factor Authentication is the new procedure and
Both gmail and ATT mail use a special password
that you have to get from them.

* If you are using a 3 party email client like Mozilla’s
Thunderbird you will have to get this password from
them before you try to add your email address.

02/11/21 Presentation by Ratsupport.com


https://support.google.com/mail/answer/185833?hl=en
https://www.att.com/support/article/email-support/KM1240308/

This Presentation

* | am going to show how to use Mozilla's
Thunderbird emall client.

* | have found it to work well and is easy to backup.

* Thunderbird has a good number of add-ons that
help the client software do many things, like
CalDAV & CardDAV sync my contacts and calender
to my computer and iphone contacts, calendar.

* | also share the lightning calendar that comes
standard in Thunderbird.
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The Install

Software made to
make email easier.

L
W.

Thunderbird is a free email application
that's easy to set up and customize - and
it's loaded with great features!

Thunderbird

Free Dounload

After install you
should see this Icon
on your desktop.

Copyright © 2005-2015 Mozilla. Al rights reserv=d,

Click the free Download button on the website: Thunderbird Website and depending
on which browser you are using, go to your Download folder and click on the
Thunderbird Setup (Version).exe and install the application.
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https://www.mozilla.org/en-US/thunderbird/

Set 1t up

 For most users the standard setup will work,

Thunderbird will ask a couple of ¢

uestions like

your emall address and password.

It IS

important that you know your email password.

* If you don't know your email password, you

might be able to look it up in your
passwords settinng.

browser

* Thunderbird i1s smart and should make your first

account for you and start working
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Lets Take a Look

&< richard@ratsupport.com

File Edit View Go Message Eventsand Tasks

W Chat

gContactSync Tools Help

&, Get Messages = o Write ~ Print & Address Book | Tag Quick Filter

I g richard @ratsupport.com
b B randerson@pacificnet Thunderbird Mail - richard@ratsupport.com
I g support@ratsupport.com

I g formcontacts@ratsupport.com

As you can see | have 10 emall
—— accounts being managed by

I @< postmaster@ratsupport.com

Thunderbird.

I < drahcir7777 @gmail.com
I < drahcir77@sbeglobal.net
b g randerson@uusd.net

b g twitter@ratsupport.com
I & catch-all@ratsupport.com

1Email

.| Read messages

/ Write a new message

» H| Local Folders <\

There is also a Local Folders
drop down that has all my

| Accounts

View settings for this account

(=4 Create a new account:

(= Email &) Chat Newsgroups Feeds

—
Create a new calendar

-~ folders that | store my old email

In.

If you were to look into my inbox
you would not see any email's

Advanced Features

4 Search messages
Manage message filters
Manage folder subscriptions

Ta  Offline settings

T Moved 1 message from Inbox to Junk
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unless they just came in. ltis
Important to move needed
emails to a folder for storage
and not keep them in your
Inbox. You can also select
Archive and keep necessary
email’s that way.

Synchronization finished at 08:57:37  |[75] Today Pane A |
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Inbox etc.

% Inbox - richard@ratsupport.co.. el |

File Edit View Go Message Eveptsand Tasks gContactSync Tools Help
.!.GetMessages - @ wite ~ B Chat Print & Address Book Tag @ Quick Filter Search... <Ctri+K= r

4z richard@ratsupport.com %> * &8 B @ Filter these messages... <Ctri+Shift+£> P
4% Inbox t ok &  Subject @ From © Date R
|~ Drafts
Sent
=] Trash
Junk
I <) randerson@pacific.net
I &< support@ratsupport.com
b &< formcon tacts@ratsupport.com
I &< postmaster@ratsupport.com
I g drahcir7 777 @gmail.com
I g drahcir77@sbcglobal.net
I &< randerson@uusd.net
I @< twitter@ratsupport.com
b < catch-all@ratsupport.com
¢+ M Local Folders

As you can see my inbox is empty. This way | only see the current emails in any of my
accounts and | either Delete new ones or move the important ones to a Local Folder
that | created.
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What an email looks like

¥ Inbox - richard@ratsupport.co... 7 7]
] File Edit View Go Message Eventsand Tasks gContactSync Tools Help

&, GetMessages ~ B/ Write |~ ®® Chat & Print ~ 2 Address Book | D Tag * | T Quick Filter Search <Cirl+K> P =

”C h ard @ ratS u p po rt COI ' l VR sichardBrataupport.com 4 | oo Unread * Starred & Contact ® Tags @ Attachment Filter these messages <Ctri+Shift+K> P
= % Inbox

) t % &  Subject ®  Correspondents ¥ Date - ®

- drahcir7777@gmail.com

with a SUbjeCt of Test. Eem— = el e
When | highlight it then | i
can see the text of the S —
emaill. | can also see

who sent the email.

. hostmaster@ratsupport.col

From Me <drahcir77T7@gmail.coms 4 Reply = Forward Archive | @ Junk (9 Delete More =

t Test 10:43 AM

To Richard Andersoni

There are a number of
buttons showing
including Reply,
Forword, Archive, Junk,
Delete and More.

Unread: 0 Tetal 1  Synchronizatien finished at 10:01:48 3] Today Pane A
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Reply to an Email

- O X

Wh I I' k th ¥, Inbox - richard@ratsupport.co.. 5 3

en | ClicKk on the i M 5 M. aondTl A T %
Re | Button I et a n F, GetMessages |~ B/ Write ~ B Chat & Print |~ £ Address Book \ R Tag ¥ | T Quick Filter Search <Cirl+K>» =
p y g /B4 octnrd@catmpport com 4 | ** Unread # Starred & Contact ® Tags @ Attachment £
*labox
H arabenT . t* B Subject £
window that allows me to s e = e
[l support@ratsupport. &

{24 formcontacts@ratsupport.com
&l drahcirT7@sbeglobal.net
[l richardanderso5154@att.net

enter my reply to the
email. | like to put the
answer above the text

[ twitter@ratsupport.com

[ postmaster@ratsupport.com
[ abuse@ratsupport.com

[l hostmaster@ratsupport.com
< webmaster@ratsupport.com
{2 catch-all@ratsupport.com

From Me <draheirf7TT7@gmail.com

the person sent me but " o

To Richard Anderson

you can put your
response below.

Just hit the Send button
to transmit the email
back to the sender.
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On 10/6/2017 10:43 AM, Richard C. Anderson

From:  Richard C Anderson <richard@ratsupport.com> richard @ratsuppart.com
Reply-To:  richard@ratsupport.com
To:  draheir7777 @gmail.com

Subject  Re: Test
Paragraph ~ | | Variable Width VB pM-AAAAA|EICEEE-E O
wrote:
lnk | @ Delete | More *
10:43 AN

Testing

Unread: 0 Total: 1 Synchronization finished at 10:01:42  ['§] Today Pane A
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About Email Addresses

* One of the neat things about Thunderbird is, you can save
and arrange your email addresses.

* Thunderbird saves new email address that came into your
account in the Collected Addresses Address Book and
you can move them into your Personal Address Book.

* You can add information into your address book such as
home address, phone number etc.

* If you want to edit an address then you only need to right
click on the email address and you can edit it and save to
the Personal Address Book.
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< richard@ratsupport.com

Local Folders

File Edit View Go Message Eventsand Tasks gContactSync Tools Help

&, Get Messages ~  # Write ~ B Chat Print & Address Book | Tag Quick Filter

I g richard@ratsupport.com
I @< randerson@pacific.net
I g support@ratsupport.com
I @< formeon tacts@ratsupport.com
I @< postmaster@ratsupport.com
b <] drahcir7 777 @gmail.com
I gr<| drahcir77 @sbcglobal.net
b randerson@uusd.net
I @ twitter@ratsupport.com
b <] catch-all@ratsupport.com
4 8 | ocal Folders
) Junk
= Trash
&, Outbox
Apple
Ashley Anderson
Blog
Conatct Submissions
3 Customers
Dropbox
Email Problems
Facebook
FreeSiteMapGenerator
[ | Friends
Good Stuff
Google
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~

Thunderbird Mail - richard@ratsupport.com

Email

=1 Read messages
50

J Write a new message
=

| Acg;mé

View settings for this account

(=4 Create a new account:

= Email %4 Chat W Newsgroups Feeds

Advanced Features

. Search messages

This image shows some of my
Local Folders. | have them for
Vendors, Customers, Dropbox,
Friends and many more.

This allows me to be able to keep
important emails and refer back to
them when needed.

In the Vendors Local Folder | have
many Sub Folders, one for each
vendor | work with. | also have
many Sub Folders for my
Customers Local Folder.
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Create a Local Folder

gl richard@ratsupport.com

If you Right Click on the Local Folders Icon
you will get a window with a number of
choices. One is New Folder.

File Edit View Go Message Eventsand Tasks gContactSync Tools Help

.!’.Getl"-ﬂessages v & Write | v -Chat Print ‘AddrESSEDDk

I g richard@ratsupport.com . .
> < randerson@padficnet Thunderbird Mail -

I gl support@ratsupport.com

By clickin the New Folder you will be
able to name a new folder and put emails
into-it.

I gl formcontacts@ratsupport.com
I gl postmaster@ratsupport.com ‘ EI'I"IEII'
I gl drahcir7 777 @gmail.com

i g drahcir77 @sbeglobal.net LG50
I g randerson@uusd.net

FRead messages

e J Write a new message
I g<| catch-all@ratsupport.com

[ M| Local ot~
Open in Mew Tab

Open in Mew Window Accounts
Search Messagi/

New Folder.. | View settings for this ac

Settings

(el Create a new account:

=<l Email ™ Chat
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Create Sub Folder

g richard@ratsupport.com
File Edit View Go Message Eventsand Tasks gContactSync Tools Help
.!’.Getl"-t'lessages + & Write |~ -Chat Print ‘Addresanok

I G| richard@ratsupport.com 63 . .
b <] ramderson@padficnet Thunderbird Mail -

I g support@ratsupport.com

I | formcontacts@ratsupport.com .
I g postmaster@ratsupport.com Email

I g<| drahcir 7777 @gmail.com
I <] drahcir77 @sbcglobal.net L5
I g randerson@uusd.net

Read messages

b 4 twitter@ratsupport.com I_,J" Write a new message

I g catch-all@ratsupport.com

4 M| | ocal Folders

) Junk
%] Trash Accounts
Ill Outbox ) ) g
Appl- View settin r this ac
Achl Open in Mew Tab
Blog Openin New Window | sy ffeate a new account:
Con Search Messages...
! =1 Email &) Chat
b Cust Mew Subfolder...
D Delete —_—
"o ER Create a new calendar
Ermna Rename
Face Compact
Free! Mark Folder Read
[+ Frier E ite Fold
TR Advanced Features
Goo .
Properties
Googre ™y Crnrrh mrarenmae

If you right click on one of your Local Folders
you will open a window that gives you a number
of choices. Rename, Delete and New Subfolder.

Sub Folders allow you to have a Vendors Local
Folder and then Keep emails from one vendor in
it't own Sub Folder.

Check all the choices so you can get a feel
w all this works and what you can do.
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How It looks In two slides

] ’ ’ o
teltepure) UTGED oo GloTd |
S
@, Quick Filter Search... <Ctri+K> R =
Cirles ew Message ke Activity Manager
it <CH
Attathments Message Filters >
8 From & Date
? t Add-ons
Find Options »
@ Print..
File »
Save As > >
View »
Folders »
o »
Empty Trash
Pty Message »
Events and Tasks ¥
gContactSyn »
Tools »
B Ei Help >

Thunderbird Options (settings) can be found by Left Clicking on the three horizontal lines
in the upper right of the window. Here you get a window with choices like Add-ons,
Options, Tools etc.
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Options

- O
I
| ®Tag > @ QuickFitter Search... <Ciri+I> P
New Message Activity Manager
richard@ratsupport.com Attachments y Message Filters >
Edit ¥ 4 Add-ons
g Options = Options
. Bt File . Account Settings
Save As ¥ T , | v MenuBar
Folders * Go s [[¥ Mail Toolbar
Empty Trash Mammam s [ Quick Filter Bar
Events and Tasks » | Status Bar
gContactSync > Toolbar Layout..
Tools > Layout
Help >

:count

) Newsgroups =/ Feeds

In the options choice you can change Account Settings and manage the toolbars and
menu items and more.
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Plugins

e rchdGppotcon | Addonstensger x| 1 @ ~ | have all but one of my
E.I:E;Efi't__?e"" (Go Message Eventsand Tasks gContactSync Jools Help - - # _____ )m” ﬂmg ..... B p PlugInS |n the Never

| Active mode. Should |
need them to function

Check to see if vour plugins are up to date

& Get Add-ons ss Shockwave Flash 18.0.0.232 .
—_— Shockwave Flash 1800 More Options Always Activate then I Can aIWayS
ofi, Extensions & ActiveTouch General Plugin Container 29.13.2015.529 (disabled) Change them to Always
/‘/‘ A ActiveTouch General Plugin Container Version 105 More Never Activate A t'
(% Appearance
sa Adobe Acrobat 11.0.12.18 (disabled) Clive.
ﬁ Plugins - Adobe PDF Plug-In For Firefox and Netscape 11.0.12 More Never Activate
gm Google Update 1.3.28.1 (disabled)
— Google Update  More Never Activate
E iTunes Application Detector 1.0.1.1 (disabled)

iTunes Detector Plug-in  More Never Activate

A Java Deployment Toolkit 8.0.510.16 is known to be vulnerable. Use with caution. More Information

Java Deployment Toolkit 8.0.510.16 11.51.2.16 (disabled)

=

- MNPRuntime Script Plug-in Library for Java(TM) Deploy More Never Activate

sa Java(TM) Platform SE 8 U51 11.51.2.16 (disabled)

- Mext Generation Java Plug-in 11.51.2 for Mozilla browsers More Never Activate

sa Microsoft Office 2010 14.0.4730.1010 (disabled)

- Office Authorization plug-in for NPAP| browsers More Never Activate

aa Microsoft Office 2010 14.0.4761.1000 (disabled)

— The plug-in allows you to open and edit files using Microsoft Office applications More Never Activate  ~

s Picasa 3.0.0.0 (disabled) v
L] Synchronization finished at 08:57:37 @ Today Pane & [}
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gl richard@ratsupport.com

Extensions

#¢ Add-ons Manager x

File Edit View Go Message Ewventsand Tasks gContactSync Tools Help

€

i Get Add-ons

* Extensions

#» Appearance

i Plugins

W

02/11/21

G

gContactSync 2.0.5

Synchronizes Google Contacts with Thunderbird More

Lightning 4.0.2

An integrated calendar for Thunderbird More

Manually sort folders 1.1

An extension that allows you to change the way Thunderbird sorts folders in the folder pane.  More

]
# =
Options Disable
Options Disable
Options Disable

Synchronization finished at 08:57:37

Presentation by Ratsupport.com

Remove

Remove

[25] Today Pane A

| have three
extensions at the
time of creating
this presentation.

gContactSync
keeps track of my
Google Contacts
and the contacts
on my Iphone
current. This
allows me to make
one change and
all devices have
the same info.

Lightning is a

Scheduling
Extension.
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4 richard@ratsupport.com *
Server Settings
Copies & Folders
Composition & Addres..,
Junk Settings
Synchronization & Stor...
Return Receipts
Security

4 randerson@pacific.net
Server Settings
Copies & Folders
Compaosition & Addres...
Junk Settings
Synchronization & Stor...
Return Receipts
Security

4 support@ratsupport.com
Server Settings
Copies & Folders
Composition & Addres...
Junk Settings
Synchronization & Stor...
Return Receipts
Security

4 formcontacts@ratsuppor...

Server Settings

y 4

Account Actions -

02/11/21

Account Settings

Account Settings - <support@ratsupport.com:

Account Mame: | support@ratsupport.com |

Default Identity

Each account has an identity, which is the information that other people see
when they read your messages.

Your Name: | RAT Support |
Email Address: |5upport@rat5upport.com / |
|
|

Reply-to Address: | support@ratsupport.com

Drganization: |

Signature text: [] Use HTML (e.g., <b>baold</b>)

[1 Attach the signature from a file inst (text, HTML, orimage):

Choose..,

[] Attach my wCard to Ssages Edit Card...

TP): | support@ratsupport.com - mail.ratsupport..

Manage |dentities...

Cancel

Make sure you have a good Reply to
Address in your settings.

You can also make a digital
signature and a vCard here.

You can add or delete accounts here
also with the Account Actions Button.

Presentation by Ratsupport.com 19



Search... <Cirl+K>

Add an Account

| Account Settings

4 richard@ratsupport.com

Server Settings
Copies & Folders

Composition & Addres...

Junk Settings

Synchronization & Stor..,

Return Receipts
Security

4 randerson@pacific.net

Server Settings
Copies & Folders

Composition & Addres...

Junk Settings

Synchronization & Stor..,

Return Receipts
Security

4 support@ratsupport.com

Server Settings
Copies & Folders

Composition & Addres...

Add Mail Account...
Add Chat Account...
Add Feed Account...
Add Other Account...

Set as Default

Remove Account

Account Actions

When you Left Click the Account Actions
Button you will get a window with a
number of choices.

Account Settings - <support@ratsupport.com>

Account Name: |5uppc-rt@rat5upport.com |

Default Identity

Each account has an identity, which is the information that other people’see
when they read your messages.

To add a Email account select Add Mail
Account. Then fill in the information and
your account will be created.

Your Mame: |RAT Support

Ernail Address:

|5upport@ratsupport.com

Reply-to Address: | support@ratsupport.com

Organization: |

Signature text: ] Use HTML (e.g.,;k{/bolddb:x]

Your name: | First Last | Your name, as shown to others

Email address: | email@example.com |

Password: |Pe-.'-:-.~.-crcl |

Remember password

e signature from a file instead (text, HTML, or image):

Choose...

Attach my vCard to messages Edit Card...

Outgoing Server (SMTP): | support@ratsupport.com - mail.ratsupport...
Manage |dentities...

Get a new account Continue Cancel )

0K Cancel

02/11/21
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4 richard@ratsupport.com
Server Settings
Copies & Folders

Junk Settings

Return Receipts
Security

4 randerson@pacific.net
Server Settings
Copies & Folders

Junk Settings
Return Receipts
Security

4 support@ratsupport.com
Server Settings
Copies & Folders

Junk Settings

Return Receipts
Security

Server Settings

Composition & Addres..,

Synchronization & Stor..

Composition & Addres..,

Synchronization 8 Stor...

Composition & Addres..,

Synchronization & Stor..,

4 formcontacts@ratsuppor..,

Account Actions

02/11/21

Junk Settings

Each of your accounts can have diferent
Junk Mail Settings (Spam).

Selection

Enable adaptirejunk mail controls for this account

If enabled, you must first train Thunderbird to identify junk mail by using SeleCtIng the ‘Junk Settlngs for an
the Junk toclbar button to mark messages as junk or not. You need to

identify both junk and nen junk messages, After that Thunderbird will be account in then Account Settings WindOW
able to mark junk automatically. . .
will product the Junk Settings.

Do not automatically mark mail as junk if the sender is in:

Collected Addresses "
drahcir7777@gmail.com .
Google-drahcir777@gmailcom You can see the settings | have for

Google-randerson@pacific.net

Google-randersen@uusd.net W riChard@ratSUPport.Com

Trust junk mail headers set by: | SpamAssassin -~

If enabled, Thunderbird will automatically consider messages marked by this
external classifier as junk.

Destination and Retention

Move new junk messages to:

® "Junk" folderon: | B| gcal Folders ™
(") Other: Choose Folder...

Automatically delete junk mail older than 1415 days

Global Junk Preferences...

Cancel
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iport.com

Message Events and Tasks gContactSync  Tools Help

Tools

Add Book Ctrl+ Shift+B
& Write |~ W Chat Print 2 hEsliee el
Saved Files Ctrl+)
rt.com Add
- -ons
- Thunderbire =" »ort.com
Activity Manager
rt.c
— Manually sort folders
ts ri.c
ShbaEs Email Chat status >
tpport.com Join Chat...
sil.com
balnet Lzl Read messa Message Filters
- Run Filters on Folder
o — ._'J.’ Write a new Run Filters on Message
ort.com Run Junk Mail Controls on Folder
% Delete Mail Marked as Junk in Folder
Import...
| Accounts Error Console Ctrl+Shift+]
— ] Allow Remote Debugging
View setting Clear Recent History... (Ctrl+5hift+Del
Account Settings
(=a Create a nev Options
= Email & Chat W Newsgroups Feeds
I
02/11/21 Presentation by Ratsupport.com

Please take the time to check
out all the menu choices and
see all the wonderful things
that can be configured in
Thunderbird.

As you might see the Account
Settings and Options can be
found here in the Tools Menu
Window also.
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Enjoyment

| hope you liked this presentation
and if you have any suggestions or
changes you would like made,
please Contact Us

This Ratsupport.com presentation
was created by Richard C.
Anderson.

| get enjoyment out of creating
tools that could help people with
their Computer Problems and Use.
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